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1. IMPORTANT NOTICE: DO NOT MOD-
IFY THIS UNIT!
This product, when installed as indicated in 
the instructions contained in this manual, 
meets FCC requirements. Modifications not 
expressly approved by Yamaha may void your 
authority, granted by the FCC, to use the 
product.

2. IMPORTANT: When connecting this prod-
uct to accessories and/or another product use 
only high quality shielded cables. Cable/s 
supplied with this product MUST be used. Fol-
low all installation instructions. Failure to fol-
low instructions could void your FCC 
authorization to use this product in the USA.

3. NOTE: This product has been tested and 
found to comply with the requirements listed 
in FCC Regulations, Part 15 for Class “B” digi-
tal devices. Compliance with these require-
ments provides a reasonable level of 
assurance that your use of this product in a 
residential environment will not result in harm-
ful interference with other electronic devices. 
This equipment generates/uses radio fre-
quencies and, if not installed and used 
according to the instructions found in the 
users manual, may cause interference harm-
ful to the operation of other electronic devices. 

* This applies only to products distributed by YAMAHA CORPORATION OF AMERICA. (class B)

Compliance with FCC regulations does not 
guarantee that interference will not occur in all 
installations. If this product is found to be the 
source of interference, which can be deter-
mined by turning the unit “OFF” and “ON”, 
please try to eliminate the problem by using 
one of the following measures:
Relocate either this product or the device that 
is being affected by the interference. 
Utilize power outlets that are on different 
branch (circuit breaker or fuse) circuits or 
install AC line filter/s.
In the case of radio or TV interference, relo-
cate/reorient the antenna. If the antenna lead-
in is 300 ohm ribbon lead, change the lead-in 
to co-axial type cable.
If these corrective measures do not produce 
satisfactory results, please contact the local 
retailer authorized to distribute this type of 
product. If you can not locate the appropriate 
retailer, please contact Yamaha Corporation of 
America, Electronic Service Division, 6600 
Orangethorpe Ave, Buena Park, CA90620
The above statements apply ONLY to those 
products distributed by Yamaha Corporation 
of America or its subsidiaries.

FCC INFORMATION (U.S.A.)

* This applies only to products distributed by YAMAHA CORPORATION OF AMERICA.

COMPLIANCE INFORMATION STATEMENT
(DECLARATION OF CONFORMITY PROCEDURE)

Responsible Party : Yamaha Corporation of America
Address : 6600 Orangethorpe Ave., Buena Park, Calif. 90620

Telephone : 714-522-9011
Type of Equipment : COMPUTER RECORDING SYSTEM

Model Name : AUDIOGRAM 3

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received including interference that may cause undes-

ired operation.
See user manual instructions if interference to radio reception is suspected.

(FCC DoC)

(class b korea)
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PRECAUTIONS
PLEASE READ CAREFULLY BEFORE PROCEEDING 

* Please keep this manual in a safe place for future reference.

 WARNING

Always follow the basic precautions listed below to avoid the possibility of serious injury or even death from 
electrical shock, short-circuiting, damages, fire or other hazards. These precautions include, but are not 
limited to, the following:

• Do not open the device or attempt to disassemble the internal 
parts or modify them in any way. The device contains no 
user-serviceable parts. If it should appear to be 
malfunctioning, discontinue use immediately and have it 
inspected by qualified Yamaha service personnel.

• Do not expose the device to rain, use it near water or in damp 
or wet conditions, or place containers on it containing 
liquids which might spill into any openings. If any liquid 
such as water seeps into the device, unplug the USB cable 
from this device immediately. Then have the device inspected 
by qualified Yamaha service personnel.

• Never insert or remove a USB cable with wet hands.

 CAUTION

Always follow the basic precautions listed below to avoid the possibility of physical injury to you or others, 
or damage to the device or other property. These precautions include, but are not limited to, the following:

• Before moving the device, remove all connected cables.
• Avoid setting all volume controls to their maximum. 

Depending on the condition of the connected devices, doing 
so may cause feedback and may damage the speakers.

• Do not expose the device to excessive dust or vibrations, or 
extreme cold or heat (such as in direct sunlight, near a 
heater, or in a car during the day) to prevent the possibility of 
panel disfiguration or damage to the internal components.

• Do not place the device in an unstable position where it 
might accidentally fall over.

• Do not use the device in the vicinity of a TV, radio, stereo 
equipment, mobile phone, or other electric devices. Doing so 
may result in noise, both in the device itself and in the TV or 
radio next to it.

• Before connecting the device to other devices, turn off the 
power for all devices. Before turning the power on or off for 
all devices, set all volume levels to minimum.

• When turning on the AC power in your audio system, always 
turn on monitor speakers LAST, to avoid speaker damage. 
When turning the power off, monitor speakers should be 
turned off FIRST for the same reason.

• Do not insert your fingers or hands in any gaps or openings 
on the device.

• Avoid inserting or dropping foreign objects (paper, plastic, 
metal, etc.) into any gaps or openings on the device. If this 
happens, unplug the USB cable from the device immediately. 
Then have the device inspected by qualified Yamaha service 
personnel.

• Do not use the device or headphones for a long period of 
time at a high or uncomfortable volume level, since this can 
cause permanent hearing loss. If you experience any hearing 
loss or ringing in the ears, consult a physician.

• Do not rest your weight on the device or place heavy objects 
on it, and avoid use excessive force on the buttons, switches 
or connectors.

Do not open Water warning

Location

Connections

Handling caution

(5)-10 1/2
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Always unplug the USB cable from a computer or turn off the computer to turn off the device when the device is not in use.

The performance of components with moving contacts, such as switches, volume controls, and connectors, deteriorates over 
time. Consult qualified Yamaha service personnel about replacing defective components.

SPECIAL NOTICES
• This manual is the exclusive copyright of Yamaha Corporation.
• The included software is the exclusive copyright of Steinberg Media Technologies GmbH.
• Copying of the software or reproduction of this manual in whole or in part by any means is expressly forbidden without the 

written consent of the manufacturer.
• Yamaha makes no representations or warranties with regard to the use of the software and documentation and cannot be 

held responsible for the results of the use of this manual and the software.
• This disk containing the software is not meant for use with an audio/visual system (CD player, DVD player, etc.). Do not 

attempt to use the disk on equipment other than a computer.
• Future upgrades of application and system software and any changes in specifications and functions will be announced 

separately.  
• The screen displays as illustrated in this manual are for instructional purposes, and may appear somewhat different from the 

screens which appear on your computer. 

The illustrations and LCD screens as shown in this manual are for instructional purposes only, and may appear somewhat 
different from those on your instrument.

This product incorporates and bundles computer programs and contents in which Yamaha owns copyrights or with respect to 
which it has license to use others' copyrights.  Such copyrighted materials include, without limitation, all computer software, 
music data, etc. Any unauthorized use of such programs and contents outside of personal use is not permitted under relevant 
laws.  Any violation of copyright has legal consequences.  DON'T MAKE, DISTRIBUTE OR USE ILLEGAL COPIES.

• Windows is a registered trademark of Microsoft® Corporation in the United States and other countries.
• Apple, Mac and Macintosh are trademarks of Apple Inc., registered in the U.S. and other countries.
• The company names and product names in this manual are the trademarks or registered trademarks of their respective 

companies.

* Specifications and descriptions in this owner’s manual are for information purposes only. Yamaha Corp. reserves the right 
to change or modify products or specifications at any time without prior notice. Since specifications, equipment or options 
may not be the same in every locale, please check with your Yamaha dealer.

MIC/INST jacks (XLR-type) are wired as follows (IEC60268 standard): pin 1: ground, pin 2: hot (+), and pin 3: cold (-).

2 1

3

Yamaha cannot be held responsible for damage caused by improper use or modifications to the device, or data that is lost 
or destroyed.
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Introduction
Thank you for choosing a Yamaha AUDIOGRAM 3 Computer Recording System. The AUDIO-
GRAM 3 includes a USB audio interface for digital audio data transfer, and Cubase AI DAW 
(Digital Audio Workstation) software for Windows® and Macintosh® computer operating sys-
tems. With the AUDIOGRAM 3 and your personal computer you have the basic elements of a 
high-performance computer recording system that is easy to set up and operate.

Please read through this manual carefully before beginning use, so that you will be able to take 
full advantage of your interface’s superlative features and enjoy trouble-free operation for years 
to come. After reading the manual, please store it in a safe place.

Contents
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Connect To Your Computer via a Single USB Cable (page 8)
The AUDIOGRAM interface connects to your computer via the supplied USB cable. Stereo audio 
data is transferred in both directions—from the interface to the computer, and vice-versa—via the 
USB connection (44.1 kHz or 48 kHz sampling frequency).

No Driver Installation Required (page 8)
The AUDIOGRAM system uses the standard drivers included in your computer’s operating system, 
so there’s no need to install any extra driver software.

Cubase AI DAW Software Supplied (page 8)
Cubase AI software, included in the AUDIOGRAM package, offers versatile, high-performance hard-
disk recording capability.

48V Phantom Power (page 18)
A PHANTOM switch supplies +48V phantom power to the channel 1 microphone input, so you can 
use high-quality phantom-powered condenser microphones for superior recording quality.

Features

Accessories
• Cubase AI DVD-ROM
• USB cable
• Owner’s Manual (this book)

Introduction
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Setup

Be sure to turn the PHANTOM 
+48V switch (★) on when 
using a phantom-powered 
condenser microphone.

Microphone

Keyboard, etc.

Computer

Headphones

Audio system

To connect a device such as a 
microphone:

To connect an instrument such 
as an electric guitar or bass:

USB cable Cubase AI
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Quick Guide

This quick setup and operation guide covers everything from installing the Cubase AI
software to using Cubase AI for recording and mixdown. While going through this section
you might find it useful to also refer to the “Controls and Functions” section on page 18, as
well as the pdf manual supplied with the Cubase AI software.

You are only permitted to use this software pursuant to the terms and conditions of the
“Steinberg Software End User License Agreement (EULA)” shown during the installation.

1 Start the computer and log on to the Administrator account.

2 Insert the included DVD-ROM into the computer’s DVD-ROM drive.

3 Follow the on-screen instructions to install the Cubase AI software.
• In order to have continuous use of Cubase AI, including support and other benefits, you

will need to register the software and activate your software license by starting it while the
computer is connected to the Internet. Click the “Register Now” button shown when the
software is started, then fill in all required fields for registration. If you do not register the
product, you will be unable to use the application after a limited period of time expires.

• To install on Mac computers double-click the “Cubase AI*.mpkg” icon or the “Cubase AI*
Start Center” icon.
“*” indicates where the version number appears in the actual icon name.

• Visit the web address below for the latest information on:
  <http://www.yamahasynth.com/>

1 Turn all gear that is to be connected to the AUDIOGRAM off or to standby mode (except the 
computer), and set the LEVEL controls and OUT LEVEL control to their minimum settings.

2 Connect microphones and/or instruments.
For details on making connections refer to the “Setup” section on page 7 and the “Controls and Func-
tions” section on page 18.

3 Set the MIC/INST switch according to the type of device connected to channel 1.
Select MIC ( ) if a microphone is connected, or INST ( ) if a guitar or similar instrument is connected.

Step 1 Installing Cubase AI

Step 2 Connecting to the AUDIOGRAM interface

Important!

NOTE

OUT LEVEL controlLEVEL controls

Be sure to turn the   PHAN-
TOM +48V switch on when 
using a phantom-powered 
condenser microphone.



Quick Guide
To prevent loud pops and noises, turn on the power to your sound gear starting with the sources 
(instruments, CD players, etc.) and ending with the audio system (monitor speakers).

1 Turn on the instruments and microphones.

2 If you are using a condenser microphone for the channel 1, turn on the PHANTOM +48V 
switch.

Observe the following precautions when turning on phantom power.

• Make sure that the PHANTOM +48V switch is off when phantom power is not 
needed.

• When turning the switch on, be sure that only a condenser microphone is con-
nected to the MIC/INST input jack. Other devices may be damaged if connected to 
phantom power. This precaution does not apply to balanced dynamic microphones 
or instruments with the phone jack, however, as these will not be affected by phan-
tom power.

• To prevent damage to speakers, be sure to turn off audio system (monitor speakers) 
before turning this switch on or off. We also recommend that you set the OUT 
LEVEL control to the minimum position before operating this switch to avoid the 
risk of loud noises that could cause hearing loss or device damage.

3 Connect the AUDIOGRAM interface to your computer using the supplied USB cable.
The POWER indicator will light to indicate that power is being applied to the AUDIOGRAM interface.

When connecting or disconnecting the USB cable be sure to turn the OUT LEVEL con-
trol all the way down.

The first time you connect to the computer’s USB connector, or change the connection
to a different USB port, a driver installation display may appear. If this occurs, wait until
the installation is complete before proceeding.

4 Turn the power to the audio system (monitor speakers).

Step 3 Powering Up the System

USB Connection Precautions
Be sure to observe the following points when connecting to the computer's USB interface.
Failure to observe these rules can result in computer freezes/hang-ups and possibly data loss 
or corruption. If the instrument or computer does hang up, restart the application or computer.

• Be sure to wake the computer from sleep/suspended/standby mode before
making a connection to the computer’s USB connector.

• Always quit all applications running on the computer before connecting or dis-
connecting the USB cable.

• Wait at least 6 seconds between connecting or disconnecting the USB cable.

CAUTION

CAUTION

CAUTION

NOTE
9AUDIOGRAM 3 Owner’s Manual



10 AUDIOGRAM 3 Owner’s Manual

Quick Guide

1 Adjust the volume on all instruments that are connected to the AUDIOGRAM interface.

Set the OUT LEVEL control to the minimum position. Failure to do so may result in 
loud noise bursts that can damage your equipment, your ears, or both.

2 Adjust the channel LEVEL controls so that the level indicator PEAK LED flash briefly on 
the highest peak levels.

3 Adjust the overall volume with the OUT LEVEL control while monitoring via headphones 
or monitor speakers.

This section describes the procedure for recording to the Cubase AI software we installed earlier via 
the AUDIOGRAM interface.

Cubase AI 6 is used for the examples in this manual. For details about other versions of Cubase
AI or Cubase AI operation in general, refer to the PDF manual provided with the software.

Cubase AI Setup

1 Set the computer output to the maximum level.
For details on how to make the setting refer to the “The recorded sound is too low in level.” section in the 
“Troubleshooting” on page 20.

2 Launch Cubase AI.

Windows:
Click [Start] → [All Program] → [Steinberg Cubase AI *] → [Cubase AI *] to launch the program. (“*” 
indicates where the version number appears in the actual icon name.) 

If the ASIO Direct Sound Full Duplex Driver dialog window appears, click [OK].

Mac:
Double-click the [Application] → [Cubase AI *]. (“*” indicates where the version number appears in the 
actual icon name.)

• If you specified a file destination when installing the Cubase AI software, launch the appli-
cation from that location.

• Create a Cubase AI shortcut or alias on your desktop so you can easily launch the pro-
gram when required.

Step 4 Adjusting Level

Step 5 Recording with Cubase AI

CAUTION

LEVEL controls
OUT LEVEL control

Level indicator

NOTE

NOTE

NOTE
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3 When the Project Assistant window appears, select the [More] menu → [Empty] and 
click [Create].

A new project is created.

Recorded Cubase AI data is stored as a “Project.”.

4 Select [Device Setup] from the [Devices] menu to open the Device Setup window.

Windows:
Select [VST Audio System] in the [Devices] field on the left side of the window. Select [ASIO DirectX 
Full Duplex Driver] in the [ASIO Driver] field on the right side of the window. A dialog box will appear 
asking “Do you want to switch the ASIO driver?”. Click [Switch].

Mac:
Select [VST Audio System] in the [Devices] field on the left side of the window. Select [USB Audio 
CODEC] in the [ASIO Driver] field on the right side of the window. A dialog box will appear asking 
“Do you want to switch the ASIO driver?”. Click [Switch].

NOTE
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Quick Guide

5 Select [ASIO DirectX Full Duplex Driver](Windows), [USB Audio CODEC](Mac) in the 
[Devices] field on the left side of the Device Setup window, and click [Control Panel] on 
the right side of the window.

Windows:
The ASIO Direct Sound Full Duplex Setup dialog box will be displayed. Check only the input port and 
output port [USB Audio CODEC] checkbox, and then click [OK] to close the dialog window.

Mac:
The [CoreAudio Device Settings] dialog window appears. Check only the [USB Audio CODEC] 
checkbox in both “Input” and “Output” of the [Input/Output Configuration] field. Click [Close] to close 
the dialog window.

6 Make sure that “USB Audio CODEC 1/2”(Windows), “Front Left/Front Right” (Mac) are 
shown in the [Port System Name] field, and check the [Visible] column in the Device 
Setup window. Click [OK] to close the window.

If the [Port System Name] field does not change, close and restart the Cubase AI, then open
the Device Setup window.

NOTE
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7 Select [VST Connections] from the [Devices] menu.

Windows:
If “Not Connected” is selected in the [Audio Device] field, click on the “Not Connected” indication, and 
then switch to [ASIO DirectX Full Duplex Driver]. 
Also set the [Outputs] in the same way, and then close the window.

Mac:
If “Not Connected” is selected in the [Audio Device] field, click on the “Not Connected” indication, and 
then switch to [USB Audio CODEC].
Also set the [Outputs] in the same way, and then close the window.  

8 Select [Add Track] → [Audio] from the [Project] menu.
The Add Audio Track dialog window appears.

9 Set the “Count” and “Configuration” parameters, and then click [Add Track].

The added tracks will appear.

You will normally use a stereo track when recording synthesizers, and a monaural track
when recording vocals or guitars.

Preparing to Record

1 Click in the track list (the area in which the track names are displayed) to select a track 
to record on.
The various settings for the selected track are available in the Inspector on the left side of the display.

NOTE

[Record Enable] button Track list

Inspector
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Quick Guide

2 Make sure the [Record Enable] button for the track to be recorded is turned on.
If the [Record Enable] button is off, click it to turn it on.

3 Play the instrument to be recorded, and adjust the AUDIOGRAM LEVEL controls so that 
the Clipping indicator never lights.

4 Specify the point at which you want to start recording via the ruler at the top of the win-
dow for the project.
Click the black area of the ruler to move the project cursor (the vertical black line) to that position.

Recording and Playback

1 Click the Transport panel [Record] button to begin recording.
When recording is started the project cursor will begin moving to the right and a box that displays the 
recording results will be created.

2 Play the part.

3 When you finish recording the track, click the Transport panel [Stop] button.
To hear playback of the track you have just recorded, use either the Transport panel [Rewind] button or 
the ruler to rewind to the beginning of the recorded section, then click the Transport panel [Start] button.

<Transport panel>
Clipping indicator

Ruler

Stop Record

Start

Rewind Forward

<Transport panel>

Recording results
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4 Select [Mixer] from the [Devices] menu to open the Mixer window.
The overall playback level will be displayed via the master section bus level meter on the right side of 
the mixer window, and the channel level will be displayed via the channel strip level meter.

To hear the playback sound via the AUDIOGRAM interface, adjust the volume with the OUT
LEVEL control.
The playback level will approximately match the recording level when the computer output is
set to the maximum level.

5 To save the project select [Save] from the [File] menu and enter a file name before actu-
ally saving the file.
Save your project frequently to insure against losing large amounts of data if a problem occurs.

6 Repeat steps 1 through 5 to record further material on the same track.

7 To record additional material on a different track, select a new track and repeat the 
record procedure.

Recording with maximum quality and minimum noise:
For optimum sound quality with minimum noise, the AUDIOGRAM signal levels should be set as high 
as possible without clipping. Check signal levels to be sent to Cubase AI for recording using the 
AUDIOGRAM level indicators while the Cubase monitoring button ( ) is turned off. Adjust the chan-
nel LEVEL controls so that the level indicator PEAK LEDs flash only occasionally on the highest input 
transients.

NOTE

Level meter Bus level meter

Monitoring button
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Quick Guide

In this section we’ll try mixing down multiple recorded audio tracks to stereo, and creating an 
audio file. Mixes can be stored as WAV or AIFF files, which can then be recorded to audio 
CDs.

1 Launch Cubase AI and open a project file.

2 Click the [Start] button on the Transport Panel.

3 While listening to playback, drag the channel strip level faders up and down to create 
the desired initial balance, then adjust the overall volume using the bus volume fader.

4 Drag the pan controls on the top of the channel strips left and right to set the stereo 
position of each track.

5 At this point you can begin to use EQ to refine your mix, and add effects.
As an example let’s try adding reverb. Click the [Edit] button ( ) on the left side of the channel strip to 
open the VST audio channel settings window. Click Inserts 1 and select “Reverb - RoomWorks SE.”

For further details refer to the pdf manual provided with the Cubase AI software.

It’s a good idea to lower the channel fader a bit before adding an effect, since the effect 
can cause an increase in the overall channel level.

Step 6 Mixing with Cubase AI

NOTE

CAUTION
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6 Double-click the left locator (starting point) and right locator (ending point) of the Trans-
port panel. Change each highlighted number, and then specify the position of the loca-
tor.

7 When the final mix adjustments have been made, go to the [File] menu and select 
[Export] → [Audio Mixdown].

8 Enter a file name and select a destination for the file as well as a file type.
If you intend to use the file to create an audio CD, select the WAV file type (AIFF on Mac OS X), 44.1 
kHz, and 16 bit.

9 Click [Export].
Progress of the mixdown operation will be shown in a progress window. When the progress window 
closes the mixdown is complete.

Files created by mixdown can be directly played back using the Windows Media Player, or
iTunes.

Bar

NOTE
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Controls and Functions

1 PHANTOM +48V Switch/Indicator
This switch toggles phantom power on and
off. If you set the switch on ( ), the
AUDIOGRAM supplies phantom power to
the MIC/INST jack (XLR-type) 8. Turn this
switch on when using a phantom-powered
condenser microphone.

• Be sure to leave this switch off 
( ) if you do not need phantom 
power.

• When turning the switch on, be 
sure that only a condenser micro-
phone is connected to the MIC/
INST input jack. Other devices 
may be damaged if connected to 
phantom power. This precaution 
does not apply to balanced 
dynamic microphones or instru-
ments with the phone jack, how-
ever, as these will not be affected 
by phantom power.

• To prevent damage to speakers, 
be sure to turn off audio system 
(monitor speakers) before turn-
ing this switch on or off. We also 
recommend that you set the OUT 
LEVEL control to the minimum 
position. Neglect of these pre-
cautions may result in large 
noise bursts that may damage 
your equipment, your ears, or 
both.

2 MIC/INST Switch
Set this switch according to the type of
device connected. Select MIC ( ) if a
microphone is connected, or INST ( ) if
an electric guitar or bass is connected.

If a device is not connected to the 
MIC/INST jack, set this switch to 
MIC ( ). Otherwise noise may 
occur.

3 LEVEL Controls
Adjusts the level of the channel signal. Use
these controls to adjust the balance
between the channels.

4 POWER Indicator
This indicator lights when power is applied
to the AUDIOGRAM interface via the USB
cable (supplied) that connects it to the
computer.

5 Level Indicators
These indicators show signal levels prior to
the OUT LEVEL control 6. The SIGNAL
LED lights when a signal is present, and
the PEAK LED lights when the signal
reaches or exceeds clipping level.  Adjust
the input channel LEVEL controls 3 so
that the PEAK LEDs flash only briefly on
occasional high-level peaks or not at all.

6 OUT LEVEL Control
Adjusts the signal level sent to the STE-
REO OUT jacks 0. This allows you to
adjust the overall volume without changing
the relative volume balance among the
channels.

When connecting or disconnecting 
the USB or audio cables be sure to 
turn the OUT LEVEL control all the 
way down.

7 USB Connector
Connects the AUDIOGRAM interface to a
USB port on your computer via the sup-
plied USB cable. In addition to transferring
audio data between the AUDIOGRAM
interface and the computer, the USB cable
supplies power from the computer to the
AUDIOGRAM interface.

Yamaha recommends that you 
use a USB cable with a length of 
1.5 meter or less.

u

t yee w rq

Control Panel

CAUTION

NOTE

CAUTION

NOTE
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8 MIC/INST Input Jack
Microphones and instruments such as gui-
tars can be connected here using XLR or
phone jack cables. Set the MIC/INST
switch 2 to MIC or INST according to the
type of device connected.

You can directly connect an elec-
tric guitar or bass without the 
need for a separate DI (Direct 
Injection) box or amp simulator.

9 LINE Input Jacks
These inputs are intended mainly for use
with instruments and equipment having
stereo outputs, such as a synthesizer or
CD player.

If devices are connected to both phone
and pin jacks, only the signal from the
device connected to the phone jacks is
input.

0 STEREO OUT Jacks
These output the mixed signal from chan-
nels 1 and 2. The output level can be
adjusted using the OUT LEVEL control.
These jacks would typically be connected
to an audio system (monitor speakers).

You can use either the phone jacks 
or pin jacks but not both at the 
same time. If both jacks are used, 
the signal is only output from the 
phone jacks.

A PHONES Jack
Connects a pair of headphones to this
jack. The PHONES jack outputs the same
signal as the STEREO OUT jacks.

■ Input Signal Flow

i!1 !0 o

Rear Panel

XLR-type Phone-type

NOTE

Phone-type Pin-type

NOTE

Input Output

Adjust the recording level 
as well as the balance 
between channels.

Adjusts the 
monitor level.

Record Playback 6 OUT LEVEL 
control

3 LEVEL
controls

5 Level 
indicator

Cubase AI
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Troubleshooting

The AUDIOGRAM interface won’t turn on.
❑ Is the included USB cable properly plugged into the interface and a computer?

The system doesn’t work properly.
❑ Are the USB cable and all necessary audio cables properly connected?
❑ Are you using a USB hub?

USB hubs can interfere with proper operation, so try connecting the AUDIOGRAM interface
directly to a USB port on the computer. If the computer has multiple USB ports, try a different
USB port.

❑ Are you using other USB devices at the same time?
If so, try removing the other device(s) and connecting only the Yamaha USB device.

The Input ports are not shown (Windows 7/Vista) 
❑ Is the sound input of your computer operating system assigned properly?

1. From the [START] menu click [Control Panel], then double-click the “Sound” icon to open the
“Sound” dialog window.

2. Click the “Recording” tab, right-click the “USB Audio CODEC” icon and select “Properties.”
3. Click the “Advanced” tab, then select “2 channel, 16 bit, 44100 Hz (CD Quality)” or “2 channel,

16 bit, 48000 Hz (DVD Quality)” in the “Default Format” field.

No sound.
❑ Are your speaker cables connected properly, or are they shorted?
❑ Are the volume controls of your sources, audio devices, applications software, computer operat-

ing system, etc., set at appropriate levels?
❑ Is the output of your computer operating system muted?
❑ Do you have several applications running at the same time?

Be sure to quit all applications you are not using.
❑ Is the sound output of your computer operating system assigned properly?

Windows 7/Vista:
1. From the [START] menu click [Control Panel], then double-click the “Sound” icon to open the

“Sound” dialog window.
2. Click the “Playback” tab and check whether the “USB Audio CODEC” icon is checked.

If not, right-click the “USB Audio CODEC” icon and select “Set as Default Device.”
3. Click the [Recording] tab and check whether the “USB Audio CODEC” icon is checked.

If not, right-click the “USB Audio CODEC” icon and select “Set as Default Device.” 

Windows XP:
1. From the [START] menu click [Control Panel], then double-click the “Sounds and Audio

Devices” icon to open the “Sounds and Audio Devices Properties” dialog window.
2. Click the “Audio” tab.
3. Set “Sound playback: Default device” and “Sound recording: Default device” to “USB Audio

CODEC.”
4. Click [OK].
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Mac:
1. Select “System Preferences ...” from the Apple menu and then select “Sound” to open the

“Sound” dialog window.
2. Click the “Input” tab and under “Choose a device for sound input” select “USB Audio CODEC”.
3. Click the “Output” tab and under “Choose a device for sound output” select “USB Audio

CODEC”.
❑ Is the sound output of the Cubase AI application assigned properly?

For setup details refer to page 8 of the Quick Guide.

The recorded sound is too low in level.
❑ Is the computer’s output level setting too low?

We recommend that you set the computer output to the maximum level and mute the computer’s
internal speaker.

Windows 7/Vista:
1. From the [START] menu click [Control Panel], then double-click the “Sound” icon to open the

“Sound” dialog window.
2. Click the “Playback” tab, right-click the “USB Audio CODEC” icon and select “Properties”.
3. Click the “Levels” tab, then set the volume slider to its maximum level.

Close the “Properties” dialog window.
4. Click the “Sounds” tab in the “Sound” dialog window, then select “No sounds” in the “Sound

Scheme.”

Windows XP:
1. From the [START] menu click [Control Panel], then double-click the “Sounds and Audio

Devices” icon to open the “Sounds and Audio Devices Properties” dialog window.
2. Click the “Volume” tab.
3. Set “Device volume” to “High.”
4. Click the “Sound” tab.
5. Select “No sound” in the “Sound scheme.”

Mac:
1. Select [System Preferences ...] from the Apple menu and then select “Sound” to open the

“Sound” dialog window.
2. Click the “Output” tab and set the volume slider at the bottom of the window to its maximum

level.
3. Click the “Sound Effect” tab and set the volume slider of the “Alert volume” slider to its mini-

mum level.
❑ Have you connected or disconnected the USB cable while Cubase AI is running?

Doing so can sometimes cause the Windows output level to be reset to its default level. Check
and raise the output level if necessary.
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Troubleshooting

The sound is intermittent or distorted.
❑ Is the PEAK LED flashing red?

You might have to lower LEVEL control levels to avoid distortion.
❑ Are any other applications, device drivers, or USB devices (scanners, printers, etc.) running at

the same time?
Be sure to quit all applications you are not using.

❑ Are you playing back a large number of audio tracks?
The number of tracks you can play at the same time will depend on the performance of the com-
puter you are using. You may experience intermittent playback if you exceed your computer’s
capabilities.

❑ Are you recording or playing long continuous sections of audio?
The audio data processing capabilities of your computer will depend on a number of factors
including CPU speed and access to external devices.

On Windows XP computers, changing some settings as outlined below can improve perfor-
mance.
1. Click [Control Panel] from the [START] menu, and double-click the “Sounds and Audio

Devices” icon to open the “Sounds and Audio Devices Properties” dialog window.
2. Click the “Volume” tab and click “Advanced” in “Speaker settings.” The “Advanced Audio

Properties” dialog window will open.
3. Click the “Performance” tab. Set “Hardware acceleration” to “Full”, and “Sample rate conver-

sion quality” to “Good.”

Don’t change these settings if you are not familiar with your computer’s operating system.
Check that the file system is set properly, and make sure that you have a plenty of free memory
(more than 128 megabytes). If the audio files you are recording or playing are not too large,
changing the virtual memory settings can sometimes improve audio performance.
In some cases it might be necessary to update your hard disk controller, device drivers, or BIOS.
Refer to your computer’s support center or support page on the web for more information.

❑ Try adding memory.
Adding more RAM memory can significantly increase your computer’s audio performance. Refer
to your computer’s owner’s manual for information on installing and setting up extra memory.

There is a delay when playing a software synthesizer via a MIDI keyboard (latency).
❑ Check the URL listed below for the latest information.

<http://www.yamahasynth.com/>
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Specifications

■ General Specifications

■ Dimensional Diagrams

Jacks MIC/INST Input Jack x 1 Combo jack (Mic/HiZ)

LINE Input Jacks (L, R) x 1 Phone jacks

x 1 RCA pin jacks

PHONES Jack x 1 Phone jack

STEREO OUT Jacks (L, R) x 1 Phone jacks

x 1 RCA pin jacks

USB Connector x 1 USB 1.1 44.1/48 kHz, 16 bit

Controls MIC/INST Switch x 1 MIC: for microphones
INST (Hi-Z): for guitars, etc.

LEVEL Control x 2 Adjust the level of CH 1, 2

PHANTOM +48V Switch x 1 48 V, only for CH1

OUT LEVEL Control x 1 Adjusts the overall signal

Indicators Phantom Power x 1 Red

Level Indicators x 1 2 points (green, red)

Power x 1 Green

Power Supply USB bus-powered

Dimensions (W x H x D) 180 x 61 x 112 mm

Net Weight 490 g

Included Accessories Cubase AI DVD-ROM
USB cable
Owner’s Manual

W: 180

D: 112108

36

H: 61

52 2

Unit: mm
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■ Block Diagram and Level Diagram
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About the accessory disk
SPECIAL NOTICE
• The software included in the accessory disk 

and the copyrights thereof are under exclusive 
ownership by Steinberg Media Technologies 
GmbH.

• Copying of the software or reproduction of this 
manual in whole or in part by any means is 
expressly forbidden without the written consent 
of the manufacturer.

• Yamaha makes no representations or warran-
ties with regard to the use of the software and 
documentation and cannot be held responsible 
for the results of the use of this manual and the 
software.

• This disk is NOT for audio/visual purpose. Do 
not attempt to play the disk on an audio/visual 
CD/DVD player. Doing so may result in irrepa-
rable damage to your player.

• Note that Yamaha does not offer technical sup-
port for the DAW software in the accessory disk.

About the DAW software in the 
accessory disk
The accessory disk contains DAW software both 
for Windows and Mac.

• Make sure to install DAW software under
the “Administrator” account.

• In order to have continuous use of the
DAW software in the accessory disk,
including support and other benefits, you
will need to register the software and acti-
vate your software license by starting it
while the computer is connected to the
Internet. Click the “Register Now” button
shown when the software is started, then
fill in all required fields for registration. If
you do not register the software, you will
be unable to use it after a limited period
of time expires.

• To install on Mac computers double-click
the “Cubase AI*.mpkg” icon or the
“Cubase AI* Start Center” icon.
“*” indicates where the version number
appears in the actual icon name.

For information about the minimum system 
requirements and latest information on the soft-
ware in the disk, check the web site below.
<http://www.yamahasynth.com/>

About software support
Support for the DAW software in the accessory 
disk is provided by Steinberg on its website at the 
following address.
http://www.steinberg.net

You can visit the Steinberg site also via the Help 
menu of the included DAW software. (The Help 
menu also includes the PDF manual and other 
information on the software.)

NOTE

http://www.yamahasynth.com/
http://www.steinberg.net
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For details of products, please contact your nearest Yamaha 
representative or the authorized distributor listed below.

Pour plus de détails sur les produits, veuillez-vous adresser à Yamaha ou 
au distributeur le plus proche de vous figurant dans la liste suivante.

Die Einzelheiten zu Produkten sind bei Ihrer unten aufgeführten 
Niederlassung und bei Yamaha Vertragshändlern in den jeweiligen 
Bestimmungsländern erhältlich.

Para detalles sobre productos, contacte su tienda Yamaha más cercana 
o el distribuidor autorizado que se lista debajo.

HEAD OFFICE
Yamaha Corporation, Digital Musical Instruments Division
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, Japan 430-8650
Tel: +81-53-460-2432

SY55

CANADA
Yamaha Canada Music Ltd.
135 Milner Avenue, Scarborough, Ontario,
M1S 3R1, Canada
Tel: 416-298-1311

U.S.A.
Yamaha Corporation of America 
6600 Orangethorpe Ave., Buena Park, Calif. 90620, 
U.S.A.
Tel: 714-522-9011

MEXICO
Yamaha de México S.A. de C.V.
Calz. Javier Rojo Gómez #1149,
Col. Guadalupe del Moral
C.P. 09300, México, D.F., México
Tel: 55-5804-0600 

BRAZIL
Yamaha Musical do Brasil Ltda.
Rua Joaquim Floriano, 913 - 4' andar, Itaim Bibi, 
CEP 04534-013 Sao Paulo, SP. BRAZIL
Tel: 011-3704-1377

ARGENTINA
Yamaha Music Latin America, S.A. 
Sucursal de Argentina
Olga Cossettini 1553, Piso 4 Norte
Madero Este-C1107CEK
Buenos Aires, Argentina
Tel: 011-4119-7000

PANAMA AND OTHER LATIN 
AMERICAN COUNTRIES/
CARIBBEAN COUNTRIES 

Yamaha Music Latin America, S.A.
Torre Banco General, Piso 7, Urbanización Marbella, 
Calle 47 y Aquilino de la Guardia, 
Ciudad de Panamá, Panamá 
Tel: +507-269-5311

THE UNITED KINGDOM/IRELAND
Yamaha Music U.K. Ltd.
Sherbourne Drive, Tilbrook, Milton Keynes, 
MK7 8BL, England
Tel: 01908-366700

GERMANY
Yamaha Music Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, Germany
Tel: 04101-3030

SWITZERLAND/LIECHTENSTEIN
Yamaha Music Europe GmbH 
Branch Switzerland in Zürich
Seefeldstrasse 94, 8008 Zürich, Switzerland
Tel: 01-383 3990

AUSTRIA
Yamaha Music Europe GmbH Branch Austria
Schleiergasse 20, A-1100 Wien, Austria
Tel: 01-60203900

CZECH REPUBLIC/SLOVAKIA/
HUNGARY/SLOVENIA

Yamaha Music Europe GmbH Branch Austria
Schleiergasse 20, A-1100 Wien, Austria 
Tel: 01-602039025

POLAND/LITHUANIA/LATVIA/ESTONIA
Yamaha Music Europe GmbH 
Branch Sp.z o.o. Oddzial w Polsce
ul. 17 Stycznia 56, PL-02-146 Warszawa, Poland
Tel: 022-500-2925

THE NETHERLANDS/
BELGIUM/LUXEMBOURG

Yamaha Music Europe Branch Benelux
Clarissenhof 5-b, 4133 AB Vianen, The Netherlands 
Tel: 0347-358 040 

FRANCE
Yamaha Musique France 
BP 70-77312 Marne-la-Vallée Cedex 2, France
Tel: 01-64-61-4000

ITALY
Yamaha Musica Italia S.P.A. 
Combo Division
Viale Italia 88, 20020 Lainate (Milano), Italy 
Tel: 02-935-771

SPAIN/PORTUGAL
Yamaha Música Ibérica, S.A.
Ctra. de la Coruna km. 17, 200, 28230 
Las Rozas (Madrid), Spain
Tel: 91-639-8888

GREECE
Philippos Nakas S.A. The Music House
147 Skiathou Street, 112-55 Athens, Greece
Tel: 01-228 2160

SWEDEN
Yamaha Scandinavia AB
J. A. Wettergrens Gata 1, Box 30053
S-400 43 Göteborg, Sweden
Tel: 031 89 34 00

DENMARK
YS Copenhagen Liaison Office
Generatorvej 6A, DK-2730 Herlev, Denmark
Tel: 44 92 49 00

FINLAND
F-Musiikki Oy
Kluuvikatu 6, P.O. Box 260, 
SF-00101 Helsinki, Finland
Tel: 09 618511

NORWAY
Norsk filial av Yamaha Scandinavia AB 
Grini Næringspark 1, N-1345 Østerås, Norway 
Tel: 67 16 77 70

ICELAND
Skifan HF
Skeifan 17 P.O. Box 8120, IS-128 Reykjavik, Iceland
Tel: 525 5000

RUSSIA
Yamaha Music (Russia)
Room 37, bld. 7, Kievskaya street, Moscow, 
121059, Russia
Tel: 495 626 5005

OTHER EUROPEAN COUNTRIES
Yamaha Music Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, Germany
Tel: +49-4101-3030

Yamaha Corporation, 
Asia-Pacific Sales & Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, 
Japan 430-8650
Tel: +81-53-460-2313

TURKEY/CYPRUS
Yamaha Music Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, Germany
Tel: 04101-3030

OTHER COUNTRIES
Yamaha Music Gulf FZE
LOB 16-513, P.O.Box 17328, Jubel Ali, 
Dubai, United Arab Emirates
Tel: +971-4-881-5868

THE PEOPLE’S REPUBLIC OF CHINA
Yamaha Music & Electronics (China) Co.,Ltd.
2F, Yunhedasha, 1818 Xinzha-lu, Jingan-qu, 
Shanghai, China
Tel: 021-6247-2211

HONG KONG
Tom Lee Music Co., Ltd.
11/F., Silvercord Tower 1, 30 Canton Road,
Tsimshatsui, Kowloon, Hong Kong
Tel: 2737-7688

INDIA
Yamaha Music India Pvt. Ltd.
5F Ambience Corporate Tower Ambience Mall Complex
Ambience Island, NH-8, Gurgaon-122001, Haryana, India
Tel: 0124-466-5551

INDONESIA
PT. Yamaha Musik Indonesia (Distributor)
PT. Nusantik
Gedung Yamaha Music Center, Jalan Jend. Gatot 
Subroto Kav. 4, Jakarta 12930, Indonesia
Tel: 021-520-2577

KOREA
Yamaha Music Korea Ltd.
8F, 9F, Dongsung Bldg. 158-9 Samsung-Dong,  
Kangnam-Gu, Seoul, Korea
Tel: 02-3467-3300

MALAYSIA
Yamaha Music (Malaysia) Sdn., Bhd.
Lot 8, Jalan Perbandaran, 47301 Kelana Jaya, 
Petaling Jaya, Selangor, Malaysia
Tel: 03-78030900

PHILIPPINES
Yupangco Music Corporation
339 Gil J. Puyat Avenue, P.O. Box 885 MCPO, 
Makati, Metro Manila, Philippines
Tel: 819-7551 

SINGAPORE
Yamaha Music (Asia) Pte., Ltd.
#03-11 A-Z Building
140 Paya Lebor Road, Singapore 409015
Tel: 6747-4374

TAIWAN
Yamaha KHS Music Co., Ltd. 
3F, #6, Sec.2, Nan Jing E. Rd. Taipei.
Taiwan 104, R.O.C.
Tel: 02-2511-8688

THAILAND
Siam Music Yamaha Co., Ltd.
4, 6, 15 and 16th floor, Siam Motors Building, 
891/1 Rama 1 Road, Wangmai, 
Pathumwan, Bangkok 10330, Thailand
Tel: 02-215-2622

OTHER ASIAN COUNTRIES 
Yamaha Corporation,
Asia-Pacific Sales & Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, 
Japan 430-8650
Tel: +81-53-460-2313

AUSTRALIA
Yamaha Music Australia Pty. Ltd.
Level 1, 99 Queensbridge Street, Southbank, 
Victoria 3006, Australia
Tel: 3-9693-5111

NEW ZEALAND
Music Works LTD
P.O.BOX 6246 Wellesley, Auckland 4680, 
New Zealand
Tel: 9-634-0099

COUNTRIES AND TRUST 
TERRITORIES IN PACIFIC OCEAN

Yamaha Corporation,
Asia-Pacific Sales & Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, 
Japan 430-8650
Tel: +81-53-460-2313

NORTH AMERICA

CENTRAL & SOUTH AMERICA

EUROPE

AFRICA

MIDDLE EAST

ASIA

OCEANIA
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